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Abstract

JaxoDr awis a Feynman graph plotting tool written in Java. It has a complete graphical user interface that allows all actions
to be carried out via mouse click-and-drag operations in a WYSIWYG fashion. Graphs may be exported to postscript/EPS
format and can be saved in XML files to be used for later sessions. OdaexaDr aw's main features is the possibility to
create ATEX code that may be used to generate graphics output, thus combining the powgl¥/18TgX with those of a
modern day drawing program. WittaxoDr aw it becomes possible to draw even complicated Feynman diagrams with just a
few mouse clicks, without the knowledge of any programming language.

Program summary

Title of program: JaxoDraw

Catalogue identifierADUA

Program summary URLhttp://cpc.cs.qub.ac.uk/summaries/ADUA

Program obtainable fromCPC Program Library, Queen’s University of Belfast, N. Ireland

Distribution format: tar gzip file

Operating systemAny Java-enabled platform, tested on Linux, Windows ME, XP, Mac OS X

Programming language usedlava

License: GPL

Nature of problem: Existing methods for drawing Feynman diagrams usually require some ‘hard-coding’ in one or the other
programming or scripting language. It is not very convenient and often time consuming, to generate relatively simple diagrams.
Method of solution:A program is provided that allows for the interactive drawing of Feynman diagrams with a graphical user
interface. The program is easy to leamdause, produces highuality output in several formats and runs on any operating
system where a Java Runtime Environment is available.

Number of bytes in distributed program, including test da2at17 863
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Number of lines in distributed program, including test da&0 000

Restrictions:Certain operations (like internal latex compilation, Postscript preview) require the execution of external commands
that might not work on untested operating systems.

Typical running time:As an interactive program, the running time depends on the complexity of the diagram to be drawn.
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1. Introduction (free) drawing programs (likef i g®) do not include
special options or commands that are necessary to

It is a widely accepted convention today in the draw Feynman diagrams with the same quality as the
scientific community to write scientific papers using ©ne achieved bypX/IATEX.
the X and BTEX environments. The high quality, A rather advanced application is tat henat -
publication-style typesetting ofTgX has made itnow | ¢a packagd=eynAr t s [5], whichiis also capable of
a de factostandard, to such an extent that some scien- Producing £TEX output (using thef eynarts. sty
tific journals only accept submission of papers in elec- Style package). However, it not only necessitates the
tronic form anymore. The portability goal oEX has ~ huge, commercial prograivat hemat i ca, but s it-
however the drawback that graphical representations S€lf @ rather sophisticated application with diagram
are only possible in very rudimentary form (using drawing just a part of its capabilities. And it does not
the BTEX pi ct ur e environment or packages using a p_rovide a GUI for the interactive drawing of arbitrary
similar approach). Useful abey are, mostly they are ~ diagrams.
too simple to draw complicated Feynman diagrams as  1here are only very few programs known to us
needed in wide parts of theoretical nuclear and parti- that allow for an interactive drawing of Feynman dia-
cle physics today (see Rdl] for an introduction to ~ 9rams, like A. La|r71a’§ prograndf ey [6], I. Musatov’s
the theory of Feynman diagrams). Feynr;anGr aph, K|W|$oft’s (commerual)l;ey n-

This problem has led to the development of more Dr aw.” or A. SantamariagFeynDi agr am® How-
sophisticated programs in the past. The UK List of €Ver all of them p_r_esent one or the other sho.rtcomlng
TeX Frequently Asked Questiohéists four possibil- in terms of portability, usabllllty, or outputqualllty.
ities to draw Feynman diagrams in conjunction with ~ Our programjaxoDr awis an attempt to circum-
IATEX: Michael Levine'sf eynman [2] bundle; Jos vgnt all the ab(_)ve mer_moned drawbacks as far as pos-
Vermaseren'axodr aw[3] package which uses Post- sible. The main requwements that we posed on our
Script specials and is thus slightly less portable but Program were that it should be easy to compile and
much more powerful; Thorsten Ohlseynnf [4] install, easy to learn and use, produce high-quality out-

package for ATEX2¢e which uses METAFONT (or put and be freely available (including its dependen-
MetaPost) to combine flexibility and portability; and  C1€S)- Furthermore, it should be as operating system
Norman Gray'sf eyn? package. These are all avail- independent (or portable) and self contained as possi-
able from the CTAN archives ble, with ideally no external dependencies. These re-
Powerful as they are, all .these methods have the guirements lead us immediately to Java as the choice

common drawback that they require some ‘hard- of our programming languadé&]. The Java technol-

coding’ from the user side in one or the other program- ogy is freely available from Sun Microsystertit
ming or scripting language. There does not exist any
graphical user interface (GUI), while modern day 6 hitp://www.xfig.org!
7 http://www.physics.odu.edu/~musatov/
- 8 http://www.feyndraw.com/
3 http://www.tex.ac.uk/cgi-bin/texfag2html?label=drawFeyn 9 http://ffisteol2.ific.uv.es/~santamar/jfeyndiagram/jfeyndiagram.
4 http:/Mww.astro.gla.ac.uk/users/norman/distrib/latex/ html.
5 http://www.ctan.org/ 10 http:/fjava.sun.com/
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is a large-scale project that will not disappear in the in XML files to be used for later sessions. One
near future and itis available for a variety of platforms. of JaxoDr aws main features is the possibility to
A working Java Runtime Environmentis the only nec- create ATeX files which make use of J. Vermaseren'’s
essary requirement to ruraxoDr aw. axodr aw packagd3] to create a Feynman diagram
As the name suggestdaxoDr aw was initially via |l at ex anddvi ps. In fact, the main motivation
meant to be a graphical user interface for Jos Ver- for writing JaxoDr awwas to create a graphical user

maseren’axodr aw package, but it may be used in-
dependently of it. However, it is in conjunction with
axodr aw that JaxoDr aw develops its main capa-
bilities because of the possibility of combining the
powers of EX/IATEX with a modern drawing pro-
gram. The main design goal daxoDr aw was con-
venience and ease-of-use, with respect to both compi-
lation/installation as well as every day usage: it should
be possible for anybody to draw even complicated
Feynman diagrams with just a few mouse clicks, with-
out the knowledge of any programming language. Be-
ing written in JavaJaxoDr aw can be used on any
platform where a Java Runtime Environment is in-
stalled. This makes it completely portable; however,
some operations, like internaTEX compilation and
postscript preview, require the execution of external

interface for theaxodr aw package.
Some ofJaxoDr aws main features are:

Completely portable.

Easy to compile/install, no external dependencies.
Complete point-and-clicgraphical user interface.
Saving and reading of graphs in XML format.
Export to Postscript, EPS and Latex format.
Setting of permanent preferences.
Internationalized: currently it comes in English,
German, French, Italian and Spanish (the User
Guide is only available in English).

Working with several graphs at a time.

Editing groups of objects.

Importing existing Latex files.

Grid with customizable size.

commands that are inherently system dependent and

are currently only tested under certain operating sys-
tems.

The present paper is organized as follovggc-
tion 2 gives a brief overview of the main features of
JaxoDr aw while Section 3contains a detailed de-
scription of the graphical user interface and usage in-
structions. A few examples of Feynman diagrams cre-
ated withJaxoDr aw are given inSection 4 in order
to illustrate the capabilities of the program, afec-
tion 5 provides some additional information.

The information provided in this document applies
to the current versiorl. 1- 0 of JaxoDr aw, for
up-to-date information on the program, like updates
and new developments, please consulttagoDr aw
Web-page athttp://altair.ific.uv.es/~JaxoDraw/home.
html.

2. Program summary

JaxoDr aw is a program for drawing Feynman
diagrams. It has a complete graphical user interface
that allows all actions to be carried out via mouse
point-and-click-and-dragperations. Graphs may be

Note that a rather detailed user guideHRML. for-
mat is included in the source distribution (in thien/
JaxoDr aw/ doc/ usr Gui de/ usr Gui de sub-di-
rectory). This user guide is accessible from within the
program and is also available in Postscript and other
formats from Ref[8].

3. Description
3.1. Prerequisites

As noted in the introduction, compilation and exe-
cution ofJaxoDr awrequires an installed and config-
ured Java environment. The program was written with
the SUN J2SDK developer kit, versidn 4. 1_01,
using the SUN avac compiler. The Java Developer
Kit and Runtime Environment are free software and
may be obtained from SUN’s web pagésPlease re-
fer to SUN’s Java documentation for information on
how to install and configure the Java environment on
your system.

exported to postscript/EPS format and can be saved 1! http:/java.sun.com
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Fig. 1. The graphical user interface béxoDr aw at start-up.

In order to profit from theAIpX export file format,
one needs J. Vermasereasodr aw'? package. This
is distributed along withlaxoDr aw (with kind per-
mission of the author) but it has to be installed inde-
pendently oflJaxoDr aw.

For using the Postscript preview option béxo-
Dr aw, one has to specify an external Postscript viewer.

3.2. Execution

The file README in the distribution home direc-
tory gives some instructions on how to compile and
run the program on different platforms. In general,
using Sun’§ avac compiler, the source is compiled
with

javac -d bin/ src/JaxoDraw *. ] ava

and the program may then be started with the com-
mand

java -cp bin/ JaxoDraw JaxoDraw

12 http://www.nikhef.nli~form/FORMdistribution/axodraw/

in the distribution home directory. Supposing that
Java is installed on the system, this will work on
any platform. The current versioh. 1- 0 supports

a number of command line parameters that may be
viewed with the kel p option. Furthermore, if a
graph was saved in an earlier session, it may be read
in directly on the command line by supplying the file
name as an argument (the extension of the file has to
be. xm ).

3.3. The layout of the graphical user interface

After first execution of the program, the user is
presented the graphical user interface as shown in
Fig. 1 The screen ofaxoDr aw s divided into five
main sections: the menu bar on top, the tool bar just
below the menu bar, the button panel on the left, the
status bar at the bottom and the drawing area (the
canvas) in the center. In the following we will describe
each of the above sections in greater detalil.

3.3.1. The menu bar
The menu bar contains four main menu bar items:
File, Edit, Options and Help.


http://www.nikhef.nl/~form/FORMdistribution/axodraw/
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File. Apart from the standard entriebldw, Open,

Cl ose, Save, Save as,Export,Print,Quit),
there is an nport item, that allows to import exist-
ing IATEX files (seeSection 3.§. The New item con-
tains a sub-menu wittNew gr aph and New t ab
entries, the latter allows to add/remove several tabs to
the canvas (se8ection 3.4.4or information on tab-
bing). TheExpor t menu item pops up a dialog where
different export formats may be chosen which may
also be previewed by clicking ther evi ew button
(note that for Postscript previews, you need to specify
an external Postscript viewer in ti ef er ences
menu).

Edit. There are four entries that lead to an immediate
action Undo, C ear, Ref r esh andPast e) while

the others fbve, Resi ze, Copy, Col or, Edi t,

Del et e, Background, Foreground, G oup,
Ungr oup) just put the program into the correspond-
ing edit mode, i.e., little red squares are displayed on
certain points of every object (for instance on the end
and middle points of lines). When the user clicks on
one of these handles, the corresponding edit opera-
tion is being carried out on the chosen object. See
Section 3.4.3or information on Group/Ungroup, and
Section 3.4.5or information on copying to/pasting
from the clipboard.

Options. There is first an itemAdd descri p-
tion that allows the addition of a text description
to a graph (this will appear as a comment in all out-
put files). TheAdd LaTeX package entry allows

the specification of additional packages that will be in-
cluded in anyATEX output via thel usepackage{}
command. Then the user may choose a Look and Feel
and the language for the current session, the type of
vertex to be drawn when in Vertex mode, whether the
tool- and status-bar are visible, whether to use anti-
aliasing and whether arrows should be drawn by de-
fault on all objects that support them. Finally, the Pref-
erences item pops up a dialog where the user may

D. Binosi, L. TheuB3l / Computer Physics Communications 161 (2004) 76-86

the User guide entry will pop up a new window with
the user guide in HTML format.

3.3.2. The tool bar

The tool bar may be switched on and off in the Op-
tions menu. If it is switched on, the tool bar contains
buttons whose action is identical to the corresponding
menu entriesNew G aph, Open, C ose, Save,
Save As, | nport, Export,Print, Paste, and
User gui de. Furthermore, there is a “quick-build”
icon that does &at ex -> EPS preview.

3.3.3. The button panel
The button panel on the left of the screen is divided
into the following subsections:

Particle buttons. There is one button for each parti-
cle type: fermion (straight line), scalar (dashed line),
ghost (dotted line), photon (wiggled line) and gluon
(pig-tailed line); and the three object types: lines, arcs
and loops. When one of these buttons is clicked the
program goes into the corresponding drawing mode,
i.e., no handles are shown on the screen and the user
may click on the canvas to start drawing the corre-
sponding object. A double line version of all the ob-
jects (with a customizable separation between the two
lines) is also available, through editing the objects.

Miscellaneous buttons. There are buttons for draw-
ing blobs (ellipses), boxes, vertices and zig-zag lines,
as well as buttons that allow the insertion of post-
script text andATEX text into the graph. When one of
these buttons is clicked the program goes into the cor-
responding drawing mode. Through right-clicking on
the vertex button a pop up menu will appear, in which
the user can choose the type of vertex drawn when in
the vertex mode (the currently available types are dot,
circle cross, square, cross and triangle).

Action buttons. These are the buttons that lead to an
immediate actionUndo andCl ear have the same
effect as the corresponding entries in i t menu,

choose several settings to be saved on a permanent baghjje theRef r esh button leads to a redrawing of the

sis. This is detailed isection 3.5

Help. The About and System i nf o items will
give some information about the current version of
JaxoDr awand the current system, respectively, while

screen. This is especially useful if antialising is used.

Edit buttons. There are a number of buttoristjve,
Resi ze, Copy, Col or, Edit, Del et e, Fore-
ground, Background, G oup and Ungr oup)
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whose actions are self-explanatory. When one of theseing button in the edit button panel and then clicking on
buttons is clicked the program goes into the corre- one of the handles specifying the object.

sponding edit mode. In particular tBei t button will

pop up a panel with all the editable parameters of the
chosen object (e.g., its position, size, color(s), etc.),
thus allowing for their fine tuning. Operations that are
not possible by interactive drawing (such as remov-
ing an arrow from a line, changing the angular exten-
sion of an arc, or choosing the double line version of
a drawn object) may be carried out through editing the
object.

3.4.1. Colors

In the current version afaxoDr aw, the user may
choose from a set of 84 colors that are presented in a
convenient color chooser panel if the user clicks an ob-
jectin color mode. The colors include all the 68 colors
defined by thecol or dvi IATEX class (on a standard
TeTeX distribution, these may be found irusr/
shar e/ texnf/tex/ pl ai n/ dvi ps/ col ordvi .
) ) ) tex) and 16 gray scales. If figures with color are
Grid and exit button. The grid button turns on the produced via thd at ex -> dvi ps command of

grldthso that thef uselr can cr:]hoosbg O?IV Tcs_rta(;n pomt? JaxoDr aw, these colors will be used as defined in the
on the canvas for placing fis ODJECLS. 1TIS GOES NOL ) o gy j style file. For direct postscript output, we

change any objects already present on the screen. Thq‘\ave tried to reproduce as closely as possible the RGB

eX|thLt1_ttor:hqut|ts] axolﬁr av:.] th ith th values of these colors, but since there are no complete
otice that generally, when e User pauses wi ®RrRGB specifications (for free), the output will not be

cursor over any of the program’s buttons, a tool tip for exactly the same as in th&TEX case.
the button comes up (this is also true for the Tool bar S .
As a reference, there are two files in the source dis-

entries). tribution of JaxoDr aw, that illustrate the differences.
Thel at excol or. ps file in theJaxoDr aw doc/
3.3.4. The status bar ) i directory gives a collection of all the colors present in
The status bar may be switched on and off in the col or dvi asproducedbyat ex -> dvi ps. The
Options menu. If it is switched on, the status bar file pscol or . ps in the same directory gives the cor-

contains three_ areas: one to dlsplay_the current file (if responding collection as produced by direct postscript
any), one to display the current drawing mode and one

. . output.
that displays the current coordinates of the cursor on P
the canvas.
3.4.2. Text
3.3.5. The canvas There are two ways of entering textdaxoDr aw.

This is the main drawing area. After choosing a POStscript text mode andhTEX text mode. Even
drawing mode from the button panel, the user may though they may be used at the same time in a graph,

draw the corresponding object by left-clicking and they will appear mutually exclusive in any derived
dragging on the canvas. output (a warning message is displayed if a Postscript

export/preview is attempted with someaTgX text

3.4. Drawing present in the graph, and vice versa).

Drawing Feynman diagrams withaxoDr aw is Postscript text mode. When entering the postscript
pretty easy and self-explaining. The program has beentext mode, the user may enter a text string that
designed with the main strategy to be easy to use. will appear directly on the screen and in any direct
In general, to draw an element of a Feynman dia- postscript output (i.e., also in any printer output). It
gram, you first choose the drawing mode by click- will not appear in any output created Miat ex ->
ing on the corresponding button in the button panel, dvi ps. In edit mode, the user may choose the text
and then draw the object by left mouse-clicking and size, color, and the font of the text object. A set
dragging on the canvas. Drawn objects may then be of Greek characters is available via a syntax that is
moved/resized or edited by choosing the correspond- derived from the correspondingleX commands:
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« \alpha . \tau the text will always be inATgX math mode. In edit

p \beta v \upsilon mode, the user may choose the size and color of
y \gamma ¢ \phi the BTEX font, and the alignment with respect to the
§ \delta x \chi current position of the text object.

e \epsilon ¥\ psi

¢ \zeta » \onega 3.4.3. Grouping

n \eta v \vartheta JaxoDr aw allows for the grouping of objects so

6 \theta ¢ \varphi that they can be moved, resized and edited in a single
¢ \iota I \Gama operation. Objects may be grouped together by two
« \kappa A \Delta different means:

A \lanbda ® \Theta

po\m A\ '—f”‘”bda Using the Group button: When the Group button in
v\ nu g\ X! the edit button panel is clicked, the program goes into
§& \xi oA Pi group mode, i.e., the user can click on the handles of
o 0 L \Sigm those objects that he wants to group together. Chosen
7 \pi @\ Phi objects will have their handles filled in light gray,

p \rho v\ Psi clicking again on the handle will take the object out
9 t varsigm Q \Qmega of the group. The grouping operation is finished when
o \sigma

the right button is clicked, the middle button cancels
the operation.

Notice that no $ signs are necessary for these
commands (any $ signs will appear verbatim on the Using the “faint box” method: Whenever the user
screen). If the user enters a string starting with a clicks the middle mouse button on the canvas and
“\'” that is not recognized as a valid Greek letter, starts dragging, there will appear a faint gray box.
it will be replaced by a question mark “?”. Super- Once the button is released,@bjects entirely located
and subscripts are available in some rudimentary inside this box will be grouped together. This method
form via a syntax that is again derived from the may be used also when the program is not in group

correspondingAIEX syntax, i.e., forA} you would
type A"{\ mu} {\ nu}. Note again that no $ signs

mode, i.e., without having the Group button pressed.

are necessary and that the brackets are always required.4.4. Tabbing

even if there is just one character as an argument.

IATEX text mode. When entering thefIEX text mode,
the user may enter a text string that will appear
only in the BTEX output file and any files created
from it via | at ex -> dvi ps. Like that all the
commands known t&*[pX in math mode are available
to the user. Notice that if a math symbol requires a
dedicatedATpX package to be displayed, the user has
to explicitly include it in the corresponding diagram
through the Add LaTeX package” entry of the
Options menu. The position of the text will be marked
on the screen by anicon that identifies it a&TgX text
object. This icon does not appear in direct postscript
or printing output. When the cursor is moved over this
icon, the corresponding input text is displayed in the
upper part of the canvas. Notice that thégX text
string will automatically be put between $ signs, so

It is possible to work with several graphs at a time
by using the tabs adaxoDr aw. At the first start-up,
the program just contains one tab “Untitled”, you may
add tabs with th&lew t ab entry in the File menu and
tabs may be closed with tli& ose t ab entry. These
operation are also presented in a pop-up menu if the
user right-clicks on a tab. Objects from one graph may
be copied to other graphs, using tbepy andPast e
entries.

3.4.5. Copying to and pasting from the clipboard

Itis possible to copy objects from one canvas to an-
other one, by first copying them to the clipboard, and
pasting the clipboard content into the desired canvas
tab afterwards. To copy objects to the clipboard, right-
click on the canvas and drag the mouse: there will ap-
pear the faint box described in the previous subsec-
tion. Once the right button is released, all objects en-
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tirely located inside this box will be copied to the clip-

IATEX file), unknown commands will be silently ig-

board (notice that the previous clipboard content will nored. The commands knowndaxoDr aware:

be lost). Next click on the canvas tab were you want

to paste the clipboard content and then click on the \ Ar r owAr ¢ \GCirc

Past e icon of the Tool bar (alternatively you can use \ Ar r owAr cn \G ueArc

thePast e item of theOpt i ons menu, or right click \ ArrowLi ne \'d uon

on the canvas tab and choose Past e entry from \ CArc \ GOval

the pop-up menu). \ CBox \GIri
\CCirc \ Li ne

3.5. Setting resources \ COval \ Phot onAr ¢
\ CTri \ Phot on

JaxoDr awallows the permanent setting of prefer- \ DashAr r owAr ¢ \ Set Col or

ences via the Preferences item in the Options menu. \ DashAr r owAr cn \Set Wdth

The first group of settings are the default HTML \ DashArrowLi ne \ Text

viewer (to view theJaxoDr aw documentation in \ DashCAr c \ usepackage

HTML format), a default text editor (used for preview- \ DashLi ne \ Vert ex

ing IATEX text output) and a default postscript viewer \ GBox \ Zi gZag

(used for previewing the printer or direct postscript
output). Note that it is necessary to specify a default
postscript viewer in order to view postscript files from
within JaxoDr aw because Java does not have an in-
ternal possibility to render postscript files. Contrary to
that, if no default HTML viewer or text editor is speci-
fied, previews will still be possible with the Java inter-
nal HTML and text rendering mechanisms which will
be used by default.
Apart from default value$or all the items present

\ docunent cl ass

\ begi n{docunent }
\ begi n{ pi cture}

(see theaxodr awuser guidé® for documentation on
these command8])). Finally, the following ETEX com-
mands are required:

If these ones are not found in the file to be

in the Options pull-down menu, the user may also jmnorted, the import process is abandoned with a

choose the initial screen size dfaxoDr aw and

warning message. When reading AAgX file gen-

specify default values for the size of the grid, the line 4 4teg by JaxoDr aw itself, lines that start with
width, the angular extent of arcs and the amplitude of oga 3ax0Comment will be’read in as a descrip-

photon and gluon objects.
If the Save button is pressed for the first time in the

tion of the graph, while

lines of the form

984 JaxoScal e{scal e} allow to read in a float-
ing point value scale factor which is used internally by
JaxoDr awto convert Java coordinates infJgX co-
ordinates. If it is not given, the scale factor defaults

Preferences dialog, a corresponding preferences file
called. Jaxor c will be created in the user's home
directory. This file is reacautomatically every time
Jaxol_)r awis started_. It isinan XML format that may to 1. Finally lines that start witl¥® JaxoDr awl D
be.e.dlted .manually in prlnmpl_e, the preferred way of are used byJaxoDraw to gather extra informa-
editing being the above mentioned Preferences menug o for identifying objects. Due to the specific algo-

dialog of the graphical user interface. rithm internally used byJaxoDr aw to draw trian-
gles, the commandsGTri and\ CTri will work
only when the imported®IX file has been generated
from JaxoDr aw itself. Otherwise they will be ig-
nored. Moreover, because of rounding errors in the ex-
port/import routines, sometimes the imported graphs

3.6. ImportingAIEX files

JaxoDr aw allows to import existingAIEX files,
even if they were not originally created hlaxo-
Dr aw. However, only commands that are known to
JaxoDr aw are actually recognized (the latter be-
ing commands that are used when exporting to a 13 http://www.nikhef.nl/~form/FORMdistribution/axodraw/


http://www.nikhef.nl/~form/FORMdistribution/axodraw/
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Fig. 2. Drawing a Higgs production mechanism.

Fig. 3. A number of possible™ v scattering diagrams.
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Fig. 4. A real world cover art design!

may be slightly different from the original ones (possi- a singleeps file. Note that it is also possible to export

ble differences being the number of wiggles/windings each diagram separately.

of photon/gluon objestand the position of objects). Fig. 4 finally illustrates thatJaxoDr aw can be
used for creating more than just technical Feynman
diagrams. This drawing was inspired by the cover of

4. Examples the book by Peskin and Schroed@y.

This section gives a few examples of Feynman 5 additional information
diagrams created witdaxoDr aw. This is done for

illustrative purposes to show some of the capabilities ~ The program and HTML manual are available
of the program. from the CPC Library. For latest information on the
Fig. 2is a screenshot that shows the editing session program you should consult th#axoDr aw home
of a Feynman diagram. The window on the leftis the page athttp:/altair.ific.uv.es/~JaxoDraw/home.hfml
working area where the user draws the graph. Note in particular, consult the Bugs section for an updated
that the ATEX labels cannot be rendered directly onthe Jist of problems and known bugs (and solutions if
screen, they are indicated by little bluegq" icons, available), and for instructions on how to report a bug.
the corresponding”TEX text is shown in a pop-up  There is also a Docs section on this page that gives
window on top of the screen if the user moves the some practical information (tips and tricks) for using
mouse over an icon. The window on the right shows JaxoDr aw.
the final Postscript output as generated by the internal  The source code oflaxoDr aw is completely
Postscript preview mechanism. documented using Javajsavadoc utility. The file
Fig. 3shows a number of Feynman diagrams that README contains information on how to create the
were all created in one editing session and exported asj avadoc API.


http://altair.ific.uv.es/~JaxoDraw/home.html
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